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1 Overview
1.1 Key features

1 Overview
Thank you for choosing to purchase this efficient, quality product!
The STAEDTLER digital pen allows all handwritten notes and
sketches on regular paper to be recorded and stored in the internal
Flash memory. This proves particularly practical whenever there is no
computer immediately at hand and you would like to retain
spontaneous thoughts or important matters. Recorded notes can then
be uploaded onto the computer, tablet or smartphone via Bluetooth®
or USB connection.
Comprising of a writing implement and a receiver, the STAEDTLER
digital pen combines ultrasonic and infrared technologies with
sophisticated algorithms. This provides a precise tracking and
positioning system which traces movement of the pen tip on any
surface and converts it into a vector image of the user's handwriting.
The digital pen transfers this vector image to the receiver for storage.
Note!
Please refer to the user manual for more detailed information
regarding all practical functions of the device!

1.1 Key features
Record handwritten notes and sketches, even when no computer
is immediately at hand.
Store handwritten notes in the integrated Flash memory.
Download the recorded handwritten notes via Bluetooth® on your
PC, smartphone (BlackBerry® and iPhone) or tablet (iPad) or via
USB connection on your computer.
Functions as a digital pen to write directly into Windows and Office
2007.
Selectable mouse indicator function.
No special paper necessary.
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1.2 Package content
Digital pen (with battery rechargeable via USB)
3 ballpoint pen refills
1 Stylus refill
Receiver (with battery rechargeable via USB)
USB cable
Metal box
Practical carrying case
Software 3 CDs (Note Manager / MyScript Studio Notes Edition for
Windows and for Mac computers / Photo Sketcher)
Quickstart Guide

1.3 Notes on safety
Warning!
Under no circumstances may batteries be thrown onto fires,
forced open or short circuited!
In the event of a leaking battery, avoid contact with skin, eyes
or mucous membranes at all costs. Rinse affected areas
immediately with plenty of clean water. Then seek immediate
medical attention.
This product is not a toy and may used by children under 14
years of age only with adult supervision.
Store batteries in a safe place inaccessible to small children.
Swallowing batteries could prove fatal. If a battery is
swallowed, seek immediate medical attention!
Keep packaging material and parts small enough to be
swallowed out of reach of children. There is a serious risk of
choking or suffocation!
Note!
Do not expose the STAEDTLER digital pen and the receiver or the
batteries to intense fluctuations in temperature, moisture, direct
sunlight, dusty conditions or shocks.
Do not carry out any repairs on the STAEDTLER digital pen or its
accessories. The product could become damaged if repairs are not
carried out correctly.
Under no circumstances may the STAEDTLER digital pen be
dismantled! This could lead to malfunctioning of the pen!

Fig. 1 Do not force the pen open!
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1.4 System requirements
To be able to install and utilise the Software CDs included in delivery,
your system must fulfil the following requirements:
Operating systems: Microsoft® Windows 8, Windows 7, Windows
Vista, Windows XP, Mac OS X 10.6 Snow Leopard, 10.7 Lion or
10.8 Mountain Lion (for Intel processors only)
Free hard drive storage: 100 MB
Recommended working memory: 512 MB
Screen resolution: min. 1024 x 768 pixels
CPU: Minimum Pentium 1 GHz
Free USB port

1.5 The STAEDTLER digital pen 2.0
1.5.1 Description STAEDTLER digital pen 2.0

Fig. 2 STAEDTLER digital pen 2.0

1 Charging indicator light
2 Slider for removing refill
3 Cap of the USB port
Charging indicator light
The charging indicator light illuminates when the pen is connected to
the computer for charging via the USB cable. The indicator light goes
out when the charging process is finished.
Slider for removing refill
Makes changing a refill possible.
Cap of the USB port
The cap protects the underlying USB port. The USB port is used for
charging the batteries of the STAEDTLER digital pen with a USB
cable.
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1.5.2 Charging the STAEDTLER digital pen 2.0
To charge the batteries of the STAEDTLER digital pen, use the
supplied USB cable.
Note!
As the battery power for the pen begins to drain, the following
symbol appears on the LCD display of the receiver.

Fig. 3 Battery symbol

This symbol is displayed for each new note. The application icon in
the taskbar changes when the batteries are charged.

Fig. 4 Application icon in the taskbar

1. Open the cap of the USB port on the upper end of the
STAEDTLER digital pen.

2. Plug the USB cable into the USB port of the STAEDTLER digital
pen.
3. Connect the other end of the USB cable to a free USB port on
your computer.
4. If the STAEDTLER digital pen is connected correctly, a red light
illuminates on the refill removal button.
Note!
The charging process is finished when the indicator light goes out.

1.5.3 Inserting / replacing a refill
Note!
The STAEDTLER digital pen is only suitable for ballpoint pen refills in
D-format, e.g. STAEDTLER 459 refills.
Note!
The ballpoint pen refills are delivered with a protective gel plug fitted
to the tip. If this is still present, it must be removed before initial use.
Removing a refill
1. Remove the pen cap from the STAEDTLER digital pen.
2. Push the button on the side of the STAEDTLER digital pen
forwards to loosen the refill.
3. Hold the pen with the refill pointing downwards. The refill will fall
out of the pen.
4. If the refill does not fall out completely, pull it out of the housing.
STAEDTLER digital pen 2.0
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1.6 The receiver
Inserting a refill
1. Insert the refill into the pen tip.
2. Push the button on the side of the STAEDTLER digital pen
backwards.
3. Push the new refill in lightly with the fingers so that it sits snugly.

Fig. 5 Inserting the refill

Attention!
Under certain circumstances, the electronics inside the pen
could sustain damage if the refill is pushed too hard!

1.6 The receiver
The STAEDTLER digital pen is a unique piece of equipment which
records handwritten notes on regular paper, stores these notes to
memory and then uploads them onto a computer, tablet or
smartphone.
It is possible to record and store up to 100 DIN A4 sides with the
STAEDTLER digital pen.
The user can read the current page number, the battery charge status
and the current operating mode on the LCD display.
A USB cable or Bluetooth® allows connection of the STAEDTLER
digital pen to a computer, tablet or smartphone whether at home or in
the office. Upload stored notes onto your computer where they can
then be subsequently managed.

11 / 130

STAEDTLER digital pen 2.0

1 Overview
1.6 The receiver

1.6.1 Description of receiver

Fig. 6 Receiver

1 LCD display:
All relevant information is provided on the display.
2 USB port:
Allows connection to the computer by way of a USB cable.
3 Power button:
In offline mode: Press briefly to create a new note or to switch to a
new page.
Hold pressed for approx. 5 seconds to switch the device on or off.
In online mode: Press briefly to switch between mouse mode and
note mode.
4 Bluetooth® button:
Press briefly to start the connection with BlackBerry® smartphones /
Windows devices (SPP appears in the display). Press and hold to
start the connection with iPhone / iPad (IRP appears in the display).
5 RESET:
Initiates a reset of the receiver.
6 Clip:
For attaching the receiver onto the paper.
Note!
Following a period of inactivity of approx. 60 minutes, the device will
shut down automatically.

STAEDTLER digital pen 2.0
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1.6.2 Resetting the device
A RESET hole is located on the side of the receiver. This can be
applied whenever the device fails to respond. To reset the receiver,
insert a sharp implement into the opening circled in the drawing.

Fig. 7 RESET

1.6.3 LCD display
The following symbols are represented on the LCD display,
depending on the respective operating state.
Symbol

Meaning
Receiver is connected to computer.
The memory of the receiver is at least 90%
full. Transfer your notes to the computer or
delete the data.
The pen battery is running low and should be
charged.
The battery in the receiver is running low and
should be charged.
The STAEDTLER digital pen is in note mode.

The STAEDTLER digital pen is in mouse
mode.

Number of stored notes.

Bluetooth® is activated.
The STAEDTLER digital pen is ready to
connect to an iPhone / iPad.
The STAEDTLER digital pen is ready to
connect to a Windows computer or
BlackBerry® smartphone.
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1.6.4 Charging the battery
The receiver has a built-in rechargeable battery which should be
charged before the first use. When the battery begins to run low,
simply recharge the battery by connecting the receiver to your
activated computer with the USB cable included in delivery.
As soon as the device is connected to the computer, the charging
process starts automatically. After approx. 3.0 hours, the battery
should be fully charged.
A fully charged battery has an operational life of approx. 15 hours.

1.6.5 Attaching the receiver to the paper
1. Open the clip on the bottom side of the receiver.
2. Fasten the device at the top centre of the paper.

Fig. 8 Receiver positioned centrally at the top

Note!
Do not block the signals being transmitted from the pen tip to the
receiver.
Inclination of the STAEDTLER digital pen to the paper should be
between 45° and 90° when writing.
Do not hold the pen as you would a paintbrush.

STAEDTLER digital pen 2.0

Fig. 9 Writing correctly

Fig. 10 Receiver obscured

Fig. 11 Receiver obscured

Fig. 12 Incorrect grip
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1.6.6 Range of the receiver
Please observe the range of the receiver.

Fig. 13 Range of the receiver

Note!
The dotted line indicates the range for each position.
The paper size is DIN-A4.

1.6.7 Connection to the computer via USB
Use the USB cable included in delivery to connect the receiver to
your computer.
1. Insert the mini USB plug into the USB port of the receiver.
2. Insert the USB plug into a free USB port on your computer.
Once connection has been established to your computer, the
following options become available:
Uploading of notes from your receiver to the computer.
Working in online mode.
Attention!
Do NOT move or tilt the receiver when in use. Attach to the
edge of the paper as shown above. Moving or tilting the device
can lead to inconsistent strokes of the pen or inaccurate
drawings!

1.6.8 Connection to the computer via Bluetooth®
In addition to data transfer via USB cable, data can also be
transmitted via Bluetooth® on Windows computers.

Fig. 14 Connection to the computer via Bluetooth
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One of the following conditions must be fulfilled for the receiver to be
connected to the PC via Bluetooth®.
The PC used features a built-in Bluetooth® receiver.
Or
A Bluetooth® dongel is connected to the PC via USB.
1. Open the corresponding context menu by clicking on the
Bluetooth® icon in the taskbar.

®

Fig. 15 Bluetooth symbol

2. In the context menu, select the Add Bluetooth® device option to
connect the STAEDTLER digital pen.

®

Fig. 16 Add Bluetooth device context menu

3. Activate the Bluetooth® function of the receiver by pressing the
Bluetooth® button.
4. All Bluetooth® devices found in the range are listed. The
STAEDTLER digital pen is displayed as "Mobile Pen". Select this
device and click on Next.

®

Fig. 17 List of all Bluetooth devices found

STAEDTLER digital pen 2.0
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1.6 The receiver
Note!
If you use Windows XP, you have to select the "Use main key from
documentation" option and enter key “0000”.
5. The connection between the PC and receiver has been
established.

Fig. 18 Completing the setup wizard

Note!
If the STAEDTLER digital pen is connected to the PC via
Bluetooth®, uploading the saved notes only works with the Note
Manager.
Note!
Cable-free data transfer via Bluetooth® does NOT work with Apple
Mac computers.
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2 Installation for Windows 7 (3 CDs)
2.1 System requirements
See chapter 1.4 System requirements.

2.2 MyScript Studio Notes Edition
2.2.1 Installation of MyScript Studio Notes Edition and MyScript InkRetriever
1. Insert the installation CD into the CD-ROM drive.
The following window opens:

Fig. 19 Installation assistant for MyScript Studio Notes Edition

Note!
The setup application should start automatically. If not, start the
application manually by activating the CD-ROM directly via the
drive.
2. Click on Next to proceed.
3. Select the language from the pull-down menu in which the
software is to be installed and click on Next.
4. Read through the licensing agreement. Select the "I accept the
agreement" option and click on Next.
Note!
If you do not accept the license agreement, it will not be possible to
install the software.

5. Click on Next to install the software in the folder indicated. Click
on Search to select an alternative folder for installation and then
click on Next.

STAEDTLER digital pen 2.0
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Fig. 20 Defining the folder for installation

6. Tick the Create desktop icon option should you wish to create an
icon on your desktop. Then click on Next.
7. Click on the Back button to review or to change your settings.
Click on the Install button to start installation of the software.

Fig. 21 Starting installation

Windows will now initiate installation. After a few seconds the setup
window appears for the integrated MyScript InkRetriever software:
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Fig. 22 Setup assistant for MyScript InkRetriever

8. Close all active applications other than the installation and then
click on Next.
9. Read through the licensing agreement. Select the I accept the
agreement option and click on Next.
Note!
If you do not accept the license agreement, it will not be possible to
install the software.
10. Click on Finish to conclude the installation.
Configuring MyScript InkRetriever
Upon installation of the software, the following window appears on
your display screen:

Fig. 23 Dialogue box following installation

STAEDTLER digital pen 2.0
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2.2 MyScript Studio Notes Edition
Perform the settings in compliance with the instructions in chapter 5.1
Configuring the upload settings.
Note!
If you are starting the application for the first time following the
installation process, a new folder with the name MyScript
Documents is created in the My Documents directory. All of your
notes are stored in this directory. If no My Documents directory
exists, the installation application creates a new My Documents
folder on your hard drive.
De-installing, upgrading or re-installing of the software will not cause
the notes in this directory to be deleted.
The software must now be activated.

2.2.2 Activating MyScript Studio Notes Edition
Automatic activation
1.

Establish connection to the Internet.

2. Open the MyScript Studio Notes Edition program via the desktop
icon or via the Start menu.
3. When first opening the MyScript Studio Notes Edition program,
this registration window appears:

Fig. 24 Activating MyScript Studio Notes Edition

4. In this software image, you have the option of acquiring different
modules (Buy) or Activating your software.

5.

21 / 130

Click on the Activate field to open a new window.
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Fig. 25 Activating MyScript Studio Notes Edition

6.

Enter the activation code in the field. As soon as a 10 – digit code
is entered, the greyed-out Activate field appears.

Note!
The activation code can be obtained from the MyScript software CD.
7.

To activate the application, click on the Activate button.

If the process has been successfully completed, the software sends
this message:
"Internet has been successfully activated. Thank you!"
Close the activation process by pressing OK.
Note!
No confidential information is sent!
If activation cannot be done directly through the Internet, an error
message appears.

Fig. 26 Error message activation not possible

You can then activate software manually.
STAEDTLER digital pen 2.0
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2.3 Note Manager (Note Manager)
Manual activation
1. Click on the Manual activation button in the error message which
appears. A page with instructions opens.

Fig. 27 Requesting the registration file

2. Read the instructions carefully and then click on OK.
All relevant data for activating the program is summarised in the
following dialogue box.
Copy the entire text into an e-mail and send it to this address:
activation.studio.support@visionobjects.com.
Note!
No confidential information is sent!
You will be sent an e-mail with the license.lic program as an
attachment.
3. Activate this program by double clicking.
Your program is now activated.
Note!
If you want to perform the activation for a computer without Internet
connection, copy the text file to another computer with Internet
connection and send it from there.
Note!
If the process does not work properly, click on this button

. You

can reach the start page by clicking on
in your browser.
You can create your query here in the help forum.
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2.3 Note Manager (Note Manager)
2.3.1 Installing Note Manager
1. Insert the installation CD into the CD-ROM drive.
The following window opens:

Fig. 28 Selecting the language

Note!
The setup application should start automatically. If not, start the
application manually by activating the CD-ROM directly via the
drive.
2. Select the language in which software should be installed.

3. Click on OK in the dialogue box to continue with the setup; a new
dialogue box opens.

Fig. 29 Welcome to the installation

4.

STAEDTLER digital pen 2.0

Click on Next to perform installation. A new dialogue box
appears.
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Fig. 26 Selecting destination folder

5. If you would like to change the destination folder for the
installation, click on the Change button and select your desired
storage location. If you are happy with the selection, click on the
Next button.
6. Click on the Install button to start installation of the software.
7. The installation program will now copy the files to the selected
folder. Pressing Finish ends the program.

Fig. 27 Completing installation
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2.4 Photo Sketcher
2.4.1 Installation of Photo Sketcher
1. Insert the installation CD into the CD-ROM drive.
2. Start Setup.exe of Photo Sketchers by double-clicking.

Fig. 30 Photo Sketcher installation welcome screen

3. In the welcome screen, click on Next; a new screen mask opens.

Fig. 31 Photo Sketcher installation storage location

4. Click on Next to install the software in the folder indicated. Click
on Browse to select an alternative folder for installation and then
click on Next.
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Fig. 32 Photo Sketcher installation successful

The installation of Photo Sketcher is now completed.
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3 Installation for Mac computers (3 CDs)
3.1 MyScript Studio Notes Edition
3.1.1 Installation of MyScript Studio Notes Edition and MyScript InkRetriever
1. Insert the installation CD into the CD-ROM drive.
2. Unpack the MyScriptStudioNotesEdition-1.3.0.977-OEMInstaller.zip file by double clicking.

3. The MyScriptStudioNotesEdition-Installer folder and the
corresponding MyScriptStudioNotesEdition.mpkg installation file
can be obtained under Downloads. Open these files by double
clicking.
The following window appears:

Fig. 33 Note on safety

4.

Click on Continue. The installation assistant opens.

Fig. 34 Installation assistant for MyScript Studio Notes Edition

Note!
The setup application does not start automatically. Start the
application manually by activating the CD-Rom directly via the drive.

STAEDTLER digital pen 2.0

5.

Click repeatedly on Continue.

6.

Read through the license agreement and click on Accept.
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Fig.35 Software license contract for MyScript Studio Notes Edition

Note!
If you do not accept the license agreement, it will not be possible to
install the software.
7.

Select the language in which the software should be installed
from the pull-down menu. Then click on Continue.

Fig. 36 Selecting the language for MyScript Studio Notes Edition

8.
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Click on the hard drive icon and then click on Continue.
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Fig. 37 Defining the installation location

9.

Click on Install.

Fig. 38 Starting installation

10. Enter your user name and your password and click on OK.

Fig. 39 Security question

STAEDTLER digital pen 2.0
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Fig. 40 Installation packet scripts

Fig. 41 Driver software MyScript InkRetriever

11. Installation concluded successfully.

Fig. 42 Installation concluded
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3.1.2 Activating MyScript Studio Notes Edition
Automatic activation
1. Establish connection to the Internet.
2. Open the MyScript Studio Notes Edition program via the desktop
icon or via the Start menu.
3. When first opening the MyScript Studio Notes Edition program,
this registration window appears:

Fig. 43 Activating MyScript Studio Notes Edition

4. In this software image, you have the option of acquiring different
modules (Buy) or Activating your software.
5.

STAEDTLER digital pen 2.0

Click on the Activate field to open a new window.
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Fig. 44 Activating MyScript Studio Notes Edition

6.

Enter the activation code in the field. As soon as you have
entered the 10 – digit code, the greyed-out Activate field appears

Note!
The activation code can be obtained from the MyScript software CD.
7.

To activate the application, click on the Activate button.

If the process has been successfully completed, the software sends
this message:
"Internet has been successfully activated. Thank you!"
Close the activation process by pressing OK.
Note!
No confidential information is sent!
If activation cannot be done directly through the Internet, an error
message appears.

Fig. 45 Error message activation not possible
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You can then activate software manually.
Manual activation
1. Click on the Manual activation button in the error message which
appears. A page with instructions opens.

Fig. 46 Requesting the registration file

2. Read the instructions carefully and then click on OK.
All relevant data for activating the program is summarised in the
following dialogue box.
Copy the entire text into an e-mail and send it to this address:
activation.studio.support@visionobjects.com.
Note!
No confidential information is sent!
You will be sent an e-mail with the license.lic program as an
attachment.
3. Activate this program by double clicking.
Your program is now activated.
Note!
If you want to perform the activation for a computer without Internet
connection, copy the text file to another computer with Internet
connection and send it from there.

STAEDTLER digital pen 2.0
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Note!
If the process does not work properly, click on this button

. You

can reach the start page by clicking on
in your browser.
You can create your query here in the help forum.

3.2 Note Manager (Note Manager)
3.2.1 Installing Note Manager
1.

Insert the installation CD into the CD-ROM drive.

2.

Initiate installation of the Note Manager by double clicking on the
Note Taker.pkg file.

3. Click on Continue in the following dialogue box to perform the
installation settings.

Fig. 47 Installation

4.

Select a target drive and click on Continue.

Fig. 48 Target drive
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5.

Click on Install to install the software.

Fig. 49 Installation

It is possible to change the destination path by clicking on Change
Install Location… and then specifying the new destination path.

Fig. 50 Destination path

Note!
De-installing, upgrading or re-installing of the software will not cause
the notes in this directory to be deleted.
6.

Click on Install.

7.

Enter your user name and your password and click on OK.

Fig. 51 Security question

8. Installation was successful.

STAEDTLER digital pen 2.0
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Fig. 52 Installation successful

3.3 Photo Sketcher
The Photo Sketcher software for labelling digital photos can not be
installed for Mac OS; it only works with Windows.
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4 Creating notes
The STAEDTLER digital pen offers two operating modes to create
handwritten notes and sketches. The offline mode and the online
mode.
Note!
Before commencing operation with the STAEDTLER digital pen,
ensure that the pen is equipped with a refill and that the batteries
are charged.
For optimum, flawless operation, we recommend using a smooth
and sturdy underlay!

4.1 Offline mode
The offline mode allows you to record and store important notes in
meetings, conferences or lectures.
1. Hold the power button on the receiver pressed for approx. 5
seconds to switch on the device.
2. Open the clip on the back and attach the receiver to the paper.
Note!
If working with operating system Windows Vista or higher, attach the
receiver centrally at the top. Selection of the attachment function is
not supported here!
3. Take the digital pen and commence writing.

Fig. 53 Writing in offline mode

Note!
Grip the pen in such a way that the signals transmitted from the pen
tip to the receiver do not become blocked.
4. Once you have finished writing your note, press the power button
briefly to store the current page and / or to begin a new page.
Following storage, the display screen of the receiver indicates that
the number of pages has increased by one.
All notes are stored in the receiver. These notes can be uploaded
onto your computer for viewing, for editing or for sending via e-mail
(see chap. 4.3 Uploading notes onto the computer).
STAEDTLER digital pen 2.0
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4.2 Online mode
In online mode, it is possible to upload notes onto your computer from
the receiver, write notes or to create sketches using the digital pen.
Moreover, the STAEDTLER digital pen can be used as a mouse in
online mode. Special functions which can only be used in online
mode are also available. These functions are described in detail in
the following sections.
Before connecting the device to your computer, ensure that the
software included in delivery (MyScript Studio Notes Edition and Note
Manager) is installed. Launch this software.
Note!
Installation of the software included in delivery "Note Manager" is a
minimum requirement for implementation of the Online function.

Fig. 54 Writing in online mode

Note!
We highly recommend placing the STAEDTLER digital pen in the
position represented when not in use to prevent any disturbance
with the mouse.

Fig. 55 STAEDTLER digital pen when not in use

If the pen remains inactive, the receiver shuts down automatically
after approx. 60 minutes. Your note, however, will be stored.
Push the power button on the receiver to quit power saving mode.
Attention!
Do not connect more than one receiver at any given time. The
devices could interfere with one another.

4.2.1 Functions of the STAEDTLER digital pen 2.0
The digital pen supports a note mode and a mouse mode.
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The standard mode can be set in 2 different ways:
With initial start of the Note Manager application or
via the Note Manager Configuration menu ("set digital note
mode").
When in use, it is possible to alternate the respective mode between
different types:
Press the power button briefly on the receiver.
Right-click on the Note Manager taskbar icon.
Tap on the virtual area with your pen.

Fig. 56 Virtual area

Note!
Following each mode change, a speech bubble with information
regarding the current mode appears and the affiliated LED lights up.
Mac computer information

Changeover between the different modes results automatically for the
Mac computer. The mouse mode becomes active as soon as the
cursor is drawn over a menu. If writing is initiated over a "free" field on
the desktop, an ink well window displaying the text is opened
automatically. This text is converted automatically and inserted into
an active text field of an application document (e.g. Indesign).
Note mode
Note mode allows the entry of sketches and notes to be observed
simultaneously on the display screen.
As soon as you write or sketch something with your digital pen, a
virtual note sheet appears on your display screen.

Fig. 57 Note window

STAEDTLER digital pen 2.0

This note sheet replicates anything which is written on actual paper
attached to the receiver. The note window toolbar allows you to
execute various basic functions such as storage, editing, sending via
e-mail or the copying of notes.
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Once the notes have been stored, they can be subsequently edited in
the Note Manager.
Note!
Ensure that the line of sight between pen and receiver does not
become blocked during the writing process. The digital pen will not
function correctly if the line of sight is not clear.
Mouse mode
In mouse mode, the STAEDTLER digital pen behaves like a regular
mouse.
To initiate the cursor function, tap the paper with the pen. The pen will
now work as a cursor.
Move the pen across the paper to move the cursor.
To click on an object, point the cursor at the respective icon and
tap on the paper with the pen.
To double-click, point the cursor at the target object and tap twice
on the paper with the pen.
To perform a right-click, point the cursor at the object and hold the
pen tip pressed on the paper. A special "Right-click cursor"
appears.

Fig. 58 Right-click cursor

Lift the pen tip from the paper. The regular "Right-click menu"
appears and the desired function can be selected.

4.2.2 Using the STAEDTLER digital pen 2.0 in Windows Vista Ink applications
The STAEDTLER digital pen allows the utilisation of Windows Vista
Ink applications such as Journal or Short notes, for example, or to
add Ink-notes in Office 2007 applications.
Note!
The receiver of the STAEDTLER digital pen must be connected to
the computer in order to be able to execute these functions.
Using the STAEDTLER digital pen in Journal
1. Select the mouse mode.
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2.

Start up Windows Journal.

3.

Begin writing on the paper while at the same time observing the
display screen.
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4.

Various functions such as Highlight text with Lasso or
Recognition can be utilised here. Furthermore, you also have the
opportunity to delete or highlight text etc.

Using the STAEDTLER digital pen in MS Word 2007
1. Open a Microsoft Word 2007 document.
2.

Click on Start freehand input in the Check menu.

3.

Select the red pen from the writing instrument toolbar. Various
ink options now become available to you. It is possible for
example to write or to provide pieces with comments.

4. Click on the blue pen on the yellow note in the writing implement
toolbar (ink comment). A speech bubble opens on the right-hand
side which can be used for your handwritten comments.
Using the Tablet PC entry field in Office applications (available
for Windows Vista and higher)
A tablet PC entry field is featured in every Office application on the
left-hand pane of the display screen. Only the edge is visible.
1. Tap on the edge of the tablet PC entry field. It now appears fully
on the display screen.
2.

Write some sentences or individual letters. Your handwriting is
recognised automatically: word for word or letter for letter.

Note!
In the event that the mouse ceases to respond, tap the pen once on
the paper. This will awaken the program from sleep mode.

4.3 Uploading notes onto the computer
Your notes can be uploaded from the receiver onto the computer in
online mode using the software. Before doing so, make sure that the
software is installed.
Your receiver must be connected to your computer with the
associated USB cable or via Bluetooth®.
Note!
Bluetooth® transmission only works with Windows.
The following symbol appears on the LCD display of your receiver
during connection.

Fig. 59 Connection
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4.3.1 Uploading notes with MyScript Studio Notes Edition
See chapter 5.1 Configuring the upload settings.

4.3.2 Uploading notes with Note Manager
See chapter 6.3 Uploading notes onto the computer.
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5 Editing notes with MyScript Studio Notes Edition
MyScript Studio Notes Edition is a fully-digital note suite which allows
you complete freedom as regards your handwritten notes.
Additionally, Note Manager can be used to export your notes to the
MyScript Studio Notes Edition character recognition engine.
This software allows you to:
View, manage and highlight your notes,
Search text in your original note files,
Convert your handwriting, shapes and tables in digital text with
outstanding accuracy,
Edit converted digital text directly in the program window,
Send the final results to Microsoft Word or other text editing
programs in a text file or to your standard e-mail application.

5.1 Configuring the upload settings
The ink retrieval settings are displayed the first time the MyScript
Studio Notes Edition application is activated and then each time
Windows is started. The latter only applies, however, if the Do not
show this page on next start-up option remains deactivated.
If the program window for configuring the note import is not opened
automatically, you have the option of opening it manually.
1. Right-click on the task bar icon

in the Windows taskbar.

2. A menu opens; select the Configure menu item.
3. The dialogue box of the MyScript InkRetriever is opened on the
screen.

5.1.1 "About" tab
Click on the link Checking the list for compatible devices in the About
tab in dialogue box MyScript InkRetriever to show a list of supported
devices on the Internet.
Select the Do not display this page upon next start-up option if the
dialogue box should not be opened upon next start-up of the MyScript
Studio Notes Edition software.

STAEDTLER digital pen 2.0
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Fig. 60 Retrieval settings dialogue box (Tab About)

5.1.2 "Retrieval settings" tab
Select the folder in the Retrieval settings tab into which the notes
from your receiver are to be stored:

Fig. 61 Retrieval settings dialogue box (tab Retrieval settings)

1. The MyScript InkRetriever suggests a storage location for your
ink files. Click on Browse to select a folder yourself.
2. Next, you must decide how the files are to be downloaded.
Choose whether all files featuring identical names within the folder
are to be overwritten.
Choose whether the notes are to be retained on the device or
whether you would like to delete the device memory after
downloading.
Choose whether MyScript Studio Notes Edition is to search
through and check each connected USB device for the presence
of "digital inks".
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Note!
If this option is activated, all new USB devices are searched. This
process can take some considerable time when searching devices
featuring greater capacities.
We recommend that the Start automatically on start-up of Windows
option remains activated in order that file monitoring can be initiated
without intervention.

5.1.3 "Device settings" tab
The STAEDTLER digital pen is detected as soon as utilisation is
initiated. The Device settings tab is displayed to manage the retrieval
of notes.

Fig. 62 Retrieval settings dialogue box (tab Device settings)

1. Enter a file name prefix in the Device settings tab so that the
notes on your STAEDTLER digital pen are more readily
recognised.

2.

It is essential that you specify the location in which the receiver is
attached to the paper, otherwise an incorrect representation of
the notes could occur.

Note!
Selection of the attachment position is not supported higher than
Windows Vista. A central position at the top will always be assumed.
If an incorrect position is specified here, your notes will be displayed
skewed on the computer!
3. Should you wish to transfer the ink files onto your computer, click
on the Download ink button.
4. Then click on OK.

STAEDTLER digital pen 2.0
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5.2 Preferences
It is possible to define preferences which will influence standard
application characteristics for certain elements.
To open the Preferences dialogue box, click on the

button.

5.2.1 "General" tab

Fig. 63 Preferences dialogue box (General tab)

Should you wish to retain fixed lines with the original line breaks
within your handwritten text, activate the Keep line returns when
converting text only option. This option only applies to segments
featuring text only conversions (no shapes or drawings).
You can specify the respective location in which all converted files
are stored following export. Enter the file path in the Folder for
exported files segment or click on the Browse button to select a
folder.

5.2.2 "Languages" tab

Fig. 64 Preferences dialogue box (Languages tab)

Select the language required for you to work within the program.
Use the Select all and Deselect buttons wherever the list is too
long.
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In the event that you would like to change the standard language
being used for the search and recognition, select the respective
language from the list and then click on the Change button.
Note!
Click on the Get more link to obtain additional languages.

5.2.3 "Search" tab

Fig. 65 Preferences dialogue box (Search tab)

For the note management functions, your MyScript Studio Notes
Edition inspects certain folders and automatically inserts new notes
displayed in these defined note folders.
Click on the Add button to select a folder in which any handwritten
documents are to be stored.
To temporarily halt inspection of a folder, it can simply be
deactivated. To remove the folder permanently from the list, click
on the folder and select the Remove button.
Select the Look in sub-folders option to incorporate the content of
other sub-folders into your defined note folders.
Select the Search in existing indexes only option if you have
recently filed a large amount of newly handwritten notes on your
disk but would now like to search through previously existing
documents only.
Note!
During this search, new documents which would normally be
included for a regular search are ignored. Indexing, which could
potentially take some considerable time, continues running in the
background: this option is practical in cases where you do not have
the time to wait for the indexing of new notes.
Once all changes have been made, click on OK to confirm your
changes.
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5.3 User interface
5.3.1 Window

Fig. 66 User interface

General:
In MyScript Studio Notes Edition, a tab window view is used. The
start page, notes, search results, etc. are each displayed in a tab (8).
Functions for general actions and opening of the preferences are
provided in the standard toolbar (1).
Functions, conversion settings and actions can be selected in the
menu bar (2).
The search panel (3) is located at the top right. You can enter key
words for your search here.
Start page tab:
In the Start page tab, you can change document sorting and grouping
by pushing the button (4).
The content of your "All my notes" or "All my searches" folder is
displayed in the main window (5).
Your notes are sorted according to tabs in the left-hand pane (6). In
addition, you will find the executed search processes there.
You can select the most important basic functions in the toolbar (7).

5.3.2 Shortcuts
Here you will find a list with the main action which you can do and
their corresponding shortcuts. These are mainly used on the start
page.
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For the note management view:
Windows

Mac computer

Create new document

Ctrl - N

N

Open document on the disk

Ctrl - O

O

Store current document

Ctrl - S

S

Close current document

Ctrl - F4

F4

Undo last action

Ctrl - Z

Z

Re-establish previously undone action

Ctrl - Y

Copy selection of notes

Ctrl - C

C

Cut selection of notes

Ctrl - X

X

Paste selection of notes

Ctrl - V

V

Delete selection

Del

Insert bold print to text

Ctrl - B

B

Insert italic face to text

Ctrl - I

I

Insert underlining to text

Ctrl - U

U

Print ink document

Ctrl - P

P

Zoom in

Ctrl - +

+

Zoom out

Ctrl - -

-

Go to beginning of document

Ctrl - Pos1

Go to end of document

Ctrl - End

Go to next page

PAGE
DOWN

PAGE DOWN

Go to previous page

PAGE UP

PAGE UP

Z

Reset
button

For document navigation:
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5.4 Managing notes
If you have created notes with your STAEDTLER digital pen, you
must first load these notes from the receiver onto your computer (see
chapter 4.3 Uploading notes onto the computer).
As soon as the note data is loaded on your computer, it is
automatically displayed on the start page of the handwriting
recognition program.

Fig. 67 Notes on the start page

All notes which you have added to the program are located on the
start page. You can visualise, select and manage your notes there.
Most actions for notes can also be executed via the right-click menu:

Fig. 68 Right-click menu

5.4.1 Importing notes
1. Connect the receiver to your computer.
The MyScript InkRetriever window opens.
In the Device settings tab, click on Download ink to import your notes
into the folder you have determined and thereby into MyScript Studio
Notes Edition.
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Fig. 60a Importing notes

Note!
Define the upload settings as described in 5.1 Configuring the
upload settings.
MyScript Studio Notes Edition contains a system that regularly
checks certain folders for new notes. New notes filed in these
folders are displayed automatically in the MyScript Studio Notes
Edition. They are then located in the "Non-tagged notes" tag.

5.4.2 Opening a note
Should you wish to open an existing file with handwritten notes:
Double-click on a document in the homepage or right-click on the
document and select Open.
Note!
It is also possible to use the Ctrl - O shortcut key.
When you would like to create a new note:
Right-click on the list with the documents and select New
document on the start page.
A new file is displayed in the list
Double-click on this file to open it.
Note!
It is also possible to use the Ctrl - N shortcut key.

5.4.3 Navigation within a note
If your document contains several pages, it is possible to navigate
from page to page.

STAEDTLER digital pen 2.0

Go to first page: click on the
- Pos1.

button or use the shortcut key Ctrl

Go to last page: click on the
- End.

button or use the shortcut key Ctrl
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Browse forwards: click on
use the PAGE DOWN key.
Browse backwards: click on

as many times as is necessary or

or use the PAGE UP key.

5.4.4 Exporting notes
MyScript Studio Notes Edition can export your handwritten notes into
various programs.
Attaching the note to an e-mail
1. Click on the

button or select File > Export.

2. On the left side of the export menu, click on the

button.

Fig.69 Export menu

The entire ink file is now forwarded as an attachment in a new e-mail
to your standard e-mail client.
All note pages are converted into a JPG image file and attached to
the message:
Exporting as an image file
1. Click on the

button or select File > Export.

2. On the left side of the export menu, click on the

button.

3. In the dialogue box displayed afterwards, select the file type,
storage location and file name and click >Save.
Export into a word file
1. Click on the

button or select File > Export.

2. On the left side of the export menu, click on the
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5.4.5 Printing notes
1. Click on the
button to print an open or tagged note.
Alternatively, select File > Print.

2. Click on the
button in the menu that appears, and the menu of
your printer opens.

5.4.6 Managing tags (classification)
As soon as your notes are in MyScript Studio Notes Edition, you can
manage them using tags. A tag can be a date, a subject, a motive,
the name of a person or company or whatever else you like.
A note can have several tags and appears under every assigned tag.
This makes it simple to manage your notes.
Displaying notes in accordance with tags
If you want to display all your notes, tagged and untagged, click on
All my notes on the start page.
To display notes assigned a specific tag, click on the name of the
corresponding tag in the homepage.

Fig. 70 Displaying notes in accordance with tags
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Tagging a document
There are three ways to tag a document:
Pull the document out of the central list on the start page to the
desired tag.
Click on the
button to open the Manage tags dialogue box.
Here you can assign the tag(s).
Right-click on the document and select Manage tags. You can
assign the desired tag(s) in the Manage tags dialogue box which
appears.

Fig. 71 Managing tags dialogue box

Removing a tag
Note!
Removing the tag will not delete the file itself! Only the tag will be
removed from this document.
There are three ways to remove a tag from a document:
Right-click on the document and select Remove all tags or
Remove current tag.
Open the Manage tags dialogue box by clicking on the
button.
Deactivate the tags which should no longer be displayed on this
note.
Right-click on the document and select Manage tags. You can
deactivate the desired tag(s) in the Manage tags dialogue box.
Note!
In the
view, coloured symbols indicate which tags have been
added to each document. If several tags use the same colour, only
one symbol is displayed with this colour.
Adding a tag
1. To create a new tag in your list, click on the
page. A pull-down menu opens.
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It is also possible to right-click on Classification on the left pane
and then select the Add tag option.
2. The newly-created tag has a standard name highlighted in blue
and is not assigned to a colour. As long as the standard name is
highlighted in blue, it can be changed. Enter the new name for
your new tag and close the entry by pressing Enter. Right-click on
the tag to change their colour, to rename them or to perform other
actions:

Fig. 72 Managing right-click menu tag

Deleting a tag
Should you wish to delete one or more tags, select the respective
tag(s) and click on the start page on the
button. Alternatively,
right-click on the tag; two options are now available for selection.
Note!
Deleting the tag will not delete the file itself! Only the tag will be
removed from this document.

5.4.7 Searching through notes
1. Enter the search item in the
search field. If more
than one word is entered, the system will search for all notes
containing any one of the respective words. To search for a
specific expression, enter the text in quotation marks.

2. You must specify the location where the search is to be
undertaken:
In All notes: Enter your search term(s) and confirm the entry
directly by clicking on
STAEDTLER digital pen 2.0

.
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In notes that were written at a specific time: Open the search
option window by clicking on
Time border.

and select an option inside the

In specific classifications: Open the search option window by
clicking on
border.

and select the tag(s) inside the Classifications

Fig. 73 Selecting search options

A search can be terminated by clicking on the
edge of the window.

button in the lower

The search results are arranged in a special view according to
relevance:

Fig. 74 Search results

Executed search processes can be found on the start page under
Searches.
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Fig.75 Executed search processes

Note!
Search processes may only be carried out in the respective
standard language!
MyScript Studio Notes Edition indexes all your documents
automatically. If a search is initiated and some documents have not
yet been adopted into the directory (indexed), this will be
implemented during the search. This will slow down the search.
Should you not wish to wait for conclusion of the search, select the
Search in existing indexes only option (Preferences dialogue box,
Notes tab). With this option active, only those notes which are
already being displayed are included in the search.

5.4.8 Modifying the size of a note page
The size of a note can be adapted in different ways:
Click on the
button in the control panel to enlarge the size of
the document.
Click on the
button in the control panel to reduce the size of
the document.
You can adjust the size or width of the window via the
function button. In addition, you can choose from the pre-set sizes.

Fig. 76 Selecting the size of a note
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5.4.9 Deleting notes
It is possible to delete a note document in a folder on your computer
directly in the program window.
Right-click on the document in the document management window
and select the Delete files from disk option. You can also tag the
document to be deleted and click on the

button.

You must confirm the delete procedure. The document is deleted
and deposited into the recycle bin.

5.4.10 Changing the standard language
Upon installation of your MyScript Studio Notes Edition application,
select a standard language for note recognition and for search. This
language is identical to the language of the user interface. If required,
the language can be changed in the preferences for search and
recognition.
Note!
MyScript Studio Notes Edition indicates all documents automatically
in order that they may be searched more quickly. The program also
indicates all documents which you have imported manually. If the
standard language is changed, all of your notes will be indexed
again in the new language (this may take considerable time).
The standard language is changed as follows:
1. To open the Preferences dialogue box, click on the

button.

2. Click on the Restore tab.
3. Select the new standard language in the list of working
languages.
4. Click on the Change button to confirm the selection.

Fig. 77 Modifying standard language
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Note!
If the standard language you have installed is the only option
available to you, additional languages can be downloaded at
http://www.visionobjects.com/en/webstore/myscript-studio-ne-win130 through the "Get more..." link.

Note!
Should you not wish to work in the original note, right-click on the
document and select Save as. Enter a file name and confirm with
Save. MyScript Studio Notes Edition creates a copy of your note file
and files it in the current directory.

5.5 Editing handwritten text
Note!
"Ink" relates to your notes in their handwritten form.
Open a document to edit handwritten text.
It is possible to store the modifications in a document by clicking on
the

function button at any time.

You can display the document you are working on in full screen
mode. To do this, click on the

button.

5.5.1 Selecting the ink
If you would like to choose a rectangle option, activate the
function and drag the cursor around the area which you would like
to select while keeping the right mouse button pressed down.
If you would like to choose an irregular option, e.g. for an
individual word or a small symbol, activate the
function and
drag the cursor around the area which you would like to select
while keeping the right mouse button pressed down.
Use Ctrl - A to select Total ink on the page.
As soon the ink is selected, you can copy, cut, delete, and move it or
change its shape.

5.5.2 Adding / erasing ink
Changes you make to your handwriting are transferred to your note
file. You will be prompted to save these changes.
To see the changes in the converted note, you must run the
conversion again.
Adding ink
Activate the
objects.
STAEDTLER digital pen 2.0

function and insert the additional text or
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Click on the arrow on the
or colour of the ink.

button to change the thickness

Erasing ink
To delete a segment of your notes, activate the
function
and drag the cursor over the ink which you would like to erase.
Click on the arrow on the
of the rubber.

button to change the thickness

Note!
To delete a large part of the ink, select it with the corresponding tool
(see 5.5.1 Selecting the ink ) and press the Del button.

5.5.3 Copying / cutting / pasting ink
1. Select the required ink using the

or

functions.

2. Edit the selected ink:
Copy the selection with Ctrl - C (or with
Cut the selection with Ctrl - X or with

).
.

Paste the copied or cut ink into a document with Ctrl - V or with
Drag the ink into its new position.

.

5.5.4 Splitting ink
If two texts are written over one another within a note, it is likely that
you have forgotten to create a new page. This can be rectified in
MyScript Studio Notes Edition using a special splitting function.
1. Open the document which contains the superimposed ink.
2.

Click in the Ink editing menu and select the Selection acc. to date
/ time function.

Fig.78 Ink editing – Selection acc. to date

3.
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Note!
This slider selects the handwritten text in accordance with the time it
was written rather than its spatial position.
4. Drag one slider to position the beginning of the selection. Drag
the other slider to position the end of the selection. The colour of
the selected ink changes.

Fig. 79 Selecting the text

5. Click on the

button to distribute ink.

Note!
The selection is copied into a new document (this document should
then be saved.) The original document is not changed. This
procedure may be repeated should you wish to split further
segments of the handwritten text.
6. To close the slider, activate any one of the other function buttons.

5.5.5 Changing ink line spacing
1.

To change the line spacing, click on the spacer item in the Ink
editing menu.

Fig.80 Ink editing - spacer

STAEDTLER digital pen 2.0
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2. Indicate the point at which you would like to change the spacing
and drag the cursor upwards to reduce the spacing or downwards
to increase the spacing.

Drag downwards to
increase the
spacing.

Drag upwards to
reduce the
spacing.

3. To close the function, activate any one of the other function
buttons.

5.5.6 Highlighting ink
1. To highlight some notes with colour, activate the
and drag the cursor over the ink you wish to highlight.
2. Click on the arrow on the
or colour of the ink.

function

button to change the thickness

Note!
This colour is indicated in the conversion results.

5.6 Converting notes
5.6.1 Settings
Global conversion settings
1. To open the Global conversion settings dialogue box, click on
Conversion> Conversion settings.
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Fig. 81 Global conversion settings dialogue box

2. To select the element being converted, select the option in the
Content type section.
3. Select the language from the language list in which your notes are
to be written.
Note!
The languages in this list are the languages which you have
selected in the Preferences dialogue box in the Languages tab.
4. Select the handwriting style used in your document:
Print: letter-for-letter font can be converted. Prerequisite for this is
that each letter is finished before the new letter begins.
Block capitals: your entire document is written exclusively in block
capitals.
Handwriting: every other style including italics.
Note!
If you are unsure, we recommend that you activate natural
handwriting.
5. Confirm your settings by clicking on OK.
Note!
When you deactivate the "Ask before converting the side band or
conversion settings" option, the dialogue box (that automatically
opens by default) is no longer display during every conversion.

5.6.2 Converting text only notes
1. Ensure when converting notes which contain text only that only
the Text option has been selected in the Content type section in
the Global conversion settings dialogue box:

STAEDTLER digital pen 2.0
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Fig. 82 Text content type

2. Click on

.

This dialogue box is opened as standard.

Fig. 83 Conversion dialogue box

3. Choose whether all pages of a document, only the current page
or a group of pages (enter the start page and the end page in the
boxes) are to be converted.
4. Should you wish to change the global conversion settings, click
on the Change button to open the respective dialogue box.
5. Click on OK to start the conversion.
The results appear in Rich Text format and can be edited directly in
your application prior to saving or exporting.
Note!
Press
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5.6.3 Notes with shapes or drawings
1. Ensure when converting notes with shapes or drawings that the
Shape and/or freeform drawing options have been selected in the
Global settings dialogue box in the Content type section.

Fig.84 Shapes / Drawings concept type

Note!
The Shape and Freeform drawing options can be combined with the
Text option wherever necessary.
2. Click on

.

This dialogue box is opened as standard.

Fig. 85 Conversion dialogue box

3. Choose whether all pages of a document, only the current page
or a group of pages (enter the start page and the end page in the
boxes) are to be converted.
4. Should you wish to modify the global conversion settings, click on
the Change button to open the respective dialogue box.
5. Click on OK or press the Enter key to start the conversion.
The results contain all shapes or drawings within the notes: it is
possible to change the type of shape as required.

STAEDTLER digital pen 2.0
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For optimum results, shapes are drawn as follows
NOT GOOD

GOOD

Draw the lines of the shapes as
evenly as possible: avoid "shaky"
lines.
When drawing closed shapes,
ensure that the end points meet
one another as precisely as
possible.
It is possible to draw open
polygons, however, they must
consist of only four lines.
For optimum results, lines and arrows must be drawn as follows
NOT GOOD

GOOD

Straight lines must be drawn as
straight as possible; avoid hooks
or curves.
Lines featuring several curves are
not converted as shapes.
Many types of arrows can be
converted as shapes, however, not
all.
Respect the size of the arrow tips
– they should not be drawn too
large in relation to the length of the
shaft.
Always finish drawing one shape before beginning with the next.
Note!
The fewer lines used when drawing shapes, the more accurate the
shape conversion.

5.6.4 Converting tables
It is possible with this application to convert tables which you have
drawn in your document, as well as their content, as long as the
conversion settings have been defined correctly.
1. To convert text which includes tables, go into the conversion
settings and select text and shape as the content type.
2. Convert your text as usual with the
is a combination of graphics and text.

button. The result

Draw the tables carefully to achieve optimum conversion accuracy. If
the table is not drawn correctly, you will end up with scrambled lines
or an endless number of table cells rather than a clean table.
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NOT GOOD

GOOD

Always draw a complete table,
including an outer border: do not
simply draw lines between the
contents.
Ensure that the table is drawn with
horizontal and vertical lines. If the
table is drawn skewed, the
conversion will be flawed.
The same number of lines and
columns must be drawn
throughout the entire table. Do not
draw stray cells within the table.

5.6.5 Areas for special contents
Adding areas
An area for special contents is a part of the document defined by you
for which you can assign another conversion mode and/or another
language. You can therefore also exclude a part of the content from
the conversion process.
1. Click on the

function button for activation.

Note!
This function is not available in ink editing mode.
2. Use the mouse to drag a border around the area which is to
contain the special content. The Special content area settings
dialogue box opens.

Fig. 86 Special content area settings dialogue box

3. Select the Special contents area settings dialogue box.
4. Following selection, click on OK or press the Enter key.
STAEDTLER digital pen 2.0
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Note!
These settings can also be performed subsequently. Double click on
the area or open the selection menu by right-clicking on the area.
Click on the Change selection of area settings option.
Editing / deleting areas
As soon as you have created an area, you can execute the following
actions:
To edit special content in an area, click on it.
Move area: Click on the area and move over the note with the
mouse pressed down.
Change size: Pull on the red handles to change the size.
Edit settings: Click on the

button to open the settings.

Only convert the area: To exclusively convert the content, click on
the

button.

Delete area: Click on the
button to delete the area. The area
content thereby remains intact.

5.6.6 Excluding areas
This method allows exclusion of a particular section from conversion.
1. Click on the

function button for activation.

Note!
This function is not available in ink editing mode.
2. Use the mouse to drag a border around the area which you would
like to exclude from conversion. The Special content area settings
dialogue box opens.

Fig. 87 Special content area settings dialogue box

3. Deactivate all options under Content type in the displayed Settings
dialogue box:
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Fig. 88 Content type dialogue box

4. Confirm with OK.
This section will now be ignored during the conversion.

5.7 Editing converted notes
5.7.1 Text only note
The text content can be edited using the keyboard as if it were a
regular text editing program.
Deleting and adding text, shifting text around, cutting, copying or
pasting. This type of editing applies for text which was converted with
these settings:

Fig. 89 Content type dialogue box

Alternatively, it is possible to select the respective text, open the text
editing functions with
Bold print
Italics

and apply these functions:

,
,

Underlined text

,

Align paragraphs (left align
justified

, right align

, centred

or

),

Text in lists with bullet points

.

You can also change the size of the text with the

button.

If exporting the edited text to Word, the formatting in the document is
retained.

STAEDTLER digital pen 2.0
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5.7.2 Text with graphic
This type of editing applies to text which was converted using these
settings: text and shape and/or freeform drawing:

Fig. 90 Content type dialogue box

1. If the

button is not active, activate by clicking.

2. Click on the line of text which you would like to edit.
3. Edit the text as desired and then press the Enter key or click on
OK.

5.7.3 Copying and selecting text
Selected text can be copied into the clipboard in order that it may be
used again elsewhere. Please note that the shapes cannot be copied
using this method. This applies for text which is converted using this
setting:

Fig. 91 Content type dialogue box

1. Click on the

function button for activation.

Note!
The indicator arrow is represented in the form of a black cross.
2. Pull the arrow over the text lines that you want to select or click in
the text to select a single work or line.
3. If you would like to copy all results for the current page, use the
Ctrl - A shortcut key to select.
4. Should you wish to copy the selection into the clipboard, use the
Ctrl - C shortcut key or the

function in the standard toolbar.

5. This copy can then be added into any other program.
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5.7.4 Replacing a shape
Geometric forms can be replaced with another shape selected from a
predefined list.
1. Click on the

function button.

2. Double-click on the shape which you would like to replace.
3. Select a shape with which you would like to replace the existing
shape from the opened list of shapes.

Fig. 92 Selecting a shape

Note!
A number is featured alongside each shape. This number
represents the degree of certainty from MyScript Studio Notes
Edition that the respective shape matches the original shape drawn
by you.

5.8 Exporting converted notes
5.8.1 Exporting into the standard text editing program
1. Click on the

function button.

2. Finally, in the export options that are displayed on the conversion
results, click on the

button.

Your text is now opened in Rich Text format in the standard text
editing program.
Should your document include shapes or drawings, these will also be
exported in Rich Text format. The text is displayed in individual text
fields.
If exporting text only, only use Text format when converting. A new
page is also created in the text editing program for each page of your
document.

STAEDTLER digital pen 2.0
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5.8.2 In an e-mail application
If you want to send your conversion result in a message generated by
your standard e-mail program, take the following steps:
1. Click on the

function.

2. In the export options, click on the
results that are displayed.

button on the conversion

Your converted text is exported directly to your e-mail messages in
Text format. With all other formats (shape / freeform), an e-mail
attachment is integrated for sending.

Fig. 93 Exporting text in e-mail

Note!
In this format, no shapes or drawings may be included in the text.

5.8.3 Into a text editor
To send your converted text (Text content type) to a Notepad (or your
standard editing program for simple text), process as follows:
1. Click on the

function.

2. In the export options, click on the
results that are displayed.

button on the conversion

Your text is copied into the standard editing program for simple text in
Text format with the original file name.
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Fig. 94 Exporting text in text editor

5.8.4 In a Word file
1. Click on the

button or select File > Export.

2. In the export options, click on the
results that are displayed.

button on the conversion

5.8.5 As an image
1. Click on the

function.

2. In the export options, click on the
results that are displayed.

button on the conversion

3. Open the File type drop-down list in the displayed dialogue box
and select an image format.
4. Select a file destination path and file name, then click Save.

5.9 Personal recognition profiles
MyScript Trainer allows you to create your own personal recognition
profile. First write a sample text in the training program using your
STAEDTLER digital pen. This sample will be used by the program to
create your own personal recognition profile.

5.9.1 Creating a recognition profile
1.

To open the Global conversion settings click on Conversion>
Conversion settings ….

2. Click on the
The Recognition profiles dialogue box opens.
3.

STAEDTLER digital pen 2.0

button.

Click on the Create new profile… button. The window for
MyScript Trainer opens.
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Fig. 95 Dialogue box MyScript Trainer

4. Click on Next to create a recognition profile file.
5. Assign the recognition program a name and a language. Then
click on Next.

Fig. 96 Selecting name and language

6. Read through the instructions for creating an example text
meticulously, if necessary print out the instructions. Click on Next
to display the example text.
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I
Fig. 97 Training process instructions

7. Copy the example text into the following two dialogue windows
and click on Next as soon as copying is complete.

Fig. 98 Example text 1

Fig. 99 Example text 2

STAEDTLER digital pen 2.0
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8. Upload the stored example text from the disk to the computer
using MyScript InkRetriever (see 4.3.1 Uploading notes with
MyScript Studio Notes Edition).
Note!
If the example text is uploaded using Note Manager, it cannot be
read by MyScript Trainer!
9. The window for uploading the stored example text opens. Select
the pages on which the example text is printed and click on Open.

Fig. 100 Uploading the example text

10. In the event that you have selected the wrong pages, modify your
selection here. Click on Next to confirm the pages.

Fig. 101 Confirming selection

11. MyScript Trainer now uploads your handwriting sample.
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Fig. 102 Uploading the handwriting sample

12. You must now check the recommended conversion of your
handwriting sample and modify as required. Please follow the
instructions in the MyScript Trainer. Once you are happy with your
handwriting sample, click on Next.

Fig. 103 Modifying the handwriting sample

Note!
At least 80% of valid examples are required in order that a profile
can be created successfully. With less than 80% of valid examples,
check whether the training units are complete. You can return to the
previous dialogue box to create new handwriting samples or to add
new pages.
13. MyScript Trainer now creates your own personal recognition
profile.

STAEDTLER digital pen 2.0
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Fig. 104 A recognition profile is created

14. Finally, you will obtain your own recognition profile which is stored
onto your computer as follows.
...\Application Data\Vision Objects\MyScript Trainer\profiles (XP)
...\Application Data\Roaming\Vision Objects\MyScript
Trainer\profiles (VISTA, WIN7)

Fig. 105 Recognition profile created successfully
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5.9.2 Managing recognition profiles
1. To open the Global conversion settings click on the
button and click on Change.
2. Click on the
The Recognition profiles dialogue box opens.

button.

3. Should you wish to activate another profile, click on the language.
Then click on the profile in the list and click on the Select button.

4. Clicking on the Check button will open the training sample so that
you can verify whether validation has been carried out correctly.
5. Clicking on the Boost button will create another profile level.
Additional samples or special symbols are announced for the
learning process. This applies for Asian languages ONLY.
6. To delete an undesired profile, select the respective profile and
click on Delete.

5.9.3 Exporting / importing recognition profiles
Exporting: click on the Export button. Select a name and the
destination path for the profile and click on the Save button.
Importing: click on the Import profile button. Navigate to the profile
file, click on the file and then click on Open.

5.10 Dictionary
5.10.1 Adding words
Should it be determined that the program is experiencing problems
recognising some frequently used words or terms, add them into your
personal dictionary. These words can be individual names, terms or
abbreviations. This process will allow the program to correctly identify
these words much more easily.
1. Click on the
button and then the Dictionary tab to add a word
to your personal dictionary.
2. In the Dictionary tab, click on Lexicon.
An insertion point is displayed in the main text field:

STAEDTLER digital pen 2.0
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Fig. 106 Preferences dialogue box (Dictionary tab)

3. Enter the new word and click on the
Enter key to confirm the word.

button, or press the

4. Add as many new words as you like using this method.
5. Click on OK to confirm the new entry or entries.
6. If you do not wish to confirm the modifications, click on the Cancel
button.

5.10.2 Editing / deleting entries
Editing dictionary entries
1. If you would like to change a dictionary entry, click on

.

2. Click on the Dictionary entry.
3. Select the word which you would like to edit from the Lexicon tab,
and click on the

button.

Note!
The selected word is displayed in the text field with a flashing
insertion point.

Fig. 107 Preferences dialogue box (Dictionary tab)
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4. Perform the required modifications and click on
you do not wish to save the modifications, click on

to confirm. If
to cancel.

5. Once finished, click on OK to confirm and to close the dialogue
box.
Deleting dictionary entries
1. Click on

.

2. Then click on the Dictionary entry.
3. Select the entry which you would like to delete from the entry list
beneath the Lexicon tab.
4. Click on the

button.

5. Click on OK to conclude the process.

5.10.3 Importing / exporting the personal dictionary
Importing the dictionary
1. Click on

.

2. Click on the Dictionary entry.
3. Click on the Import button.
Note!
It is also possible to import your own text files in UTF-8 format.
4. Navigate to the profile file and select it.
5. Click on Open or double-click on the file name.
Exporting the dictionary
1. Click on

.

2. Click on the Dictionary entry.
3. Click on the Export button in the dialogue box.
4. Select a location into which the dictionary should be stored. Enter
a file name.
Note!
The dictionary, including all words and automatic replacements, is
stored as a text file. The standard file destination path for the export
/ import of dictionaries is: My files/MyScript Documents/export.
5. Click on the Save button as confirmation.

STAEDTLER digital pen 2.0
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5.10.4 Managing automatic replacements
Your application manages replacements automatically: if
abbreviations, initials or acronyms are used in your notes, these can
be replaced automatically by a complete name or term during
conversion.
Adding an automatic replacement
1. For access to the automatic replacements, click on the
and on the Dictionary tab, and then click on the Auto
replacements tab.

button

2. Add an automatic replacement:

Fig. 108 Text fields for automatic replacement

3. Enter the shortened form or abbreviation (e.g. "MPI") which is to
be replaced by another text into the left-hand side of the text field.
4. Then enter the long form (e.g. Max Planck Institute) which
replaces the original text in all positions where it is located in the
right-hand side of the text field.

Fig. 109 Preferences dialogue box (Dictionary tab - automatic replacement)

5. Click on
dictionary.

to add your automatic replacement into the

6. Once finished, click on OK to close the dialogue box.
Modifying an automatic replacement
1. To modify an automatic replacement, select the entry which you
would like to modify and click on the

button.

2. The selected entry can be displayed in the text fields and may be
edited.
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3. Perform the required modifications and click on

to confirm. If

you do not wish to save the modifications, you can click on
cancel.

to

4. Click on OK to close the dialogue box.

Fig. 110 Preferences dialogue box (Dictionary tab - automatic replacement)

Deleting an automatic replacement

1. To delete an automatic replacement, click on the entry which you
would like to remove from the list.
2. Click on the

button.

3. Once finished, click on OK to close the dialogue box.
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6 Editing the notes with Note Manager (Note Manager)
The Note Manager allows you to store, display, search, copy and
export notes.
It is set in Windows Explorer format so that you can search through
your files in the left-hand section and observe them in the right-hand
section.

Fig. 111 Note Manager

6.1 Defining settings
Define the standard preferences such as note colour, automatic
storage characteristics, print preferences etc. in the Preference
dialogue window.
The dialogue window is divided into four registration cards, each
controlling a different aspect of the system: general, printing and ink.

6.1.1 Access to preferences
Open the Configuration menu in the Note Manager and select the
Preferences option.

6.1.2 "General" tab
The time interval (in minutes) can be determined in the Auto-save
note in entry field once the system has already stored your notes.
Note!
This Auto-save activates a restore function automatically which
restores your data in the version in which it was last stored in the
event of a system shutdown or power failure.
Tick the Load when Windows starts checkbox to open Note
Manager automatically each time the computer is switched on.
Tick the Save sticky notes on exit checkbox to store all newly
created memos automatically. The stored memos appear as soon
as the computer is switched on next time or when the Note
Manager is restarted.
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Fig. 112 Preferences dialogue boxes (General tab)

6.1.3 "Mobile" tab
An automatic upload can be set in the Mobile tab. This tab is only
visible if the STAEDTLER digital pen is connected to the computer.
Three different selection possibilities are available to you.
YES - Your notes are uploaded automatically as soon as the
receiver is connected to the computer.
NO - Your notes must be uploaded manually.
ASK ME - You will be asked by the Note Manager each time the
receiver is connected whether you would like to upload your notes.

Fig. 113 Preferences dialogue boxes (Mobile tab)

6.1.4 "Print" tab
The settings for printing can be performed here.
Tick the Note per page checkbox to verify that only one note per
page will be printed.
Tick the Centre note on page checkbox to verify that notes will
always be printed centred.
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Fig. 114 Preferences dialogue boxes (Printing tab)

6.1.5 "Paper Holder" tab
In the Paper Holder tab, it is possible to adjust transparency of the
paper holder.
Pull the slider beneath Paper holder opacity to the required degree
of transparency.
Once all settings have been performed, confirm your entry by clicking
on OK.

Fig. 115 Preferences dialogue boxes (Paper Holder tab)

6.2 Toolbox
The Note Manager toolbox includes buttons which grant you easy
access to the menu commands used most regularly.

The following table contains a list of all buttons in the toolbox along
with a functional description.
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Toolbox
button

Description
Upload – In online mode, it is possible to upload all of your
notes from the receiver onto the computer using the Note
Manager software.
Notes to text – converts handwritten notes into text (in
Windows Vista and Windows 7 only).
Convert your notes into text using MyScript Studio Notes
Edition (only possible if the recognition software is
installed).
Merge notes – merges several notes into one note.
Cut – Cuts out the selected notes and stores them in the
clipboard.
Copy – Copies the selected notes and stores them in the
clipboard.
Paste – Inserts everything which was most recently stored
in the clipboard by copying or cutting.
Delete – Deletes selected note(s).
Edit notes – Edits a selected note.
Print – Prints selected note(s).
Show as sticky note – Converts a note to sticky note.
Show as paper holder – Converts a note to paper holder.
Small thumbnail – Displays small thumbnails in the Note
Manager view.
Medium thumbnail - Displays medium-sized thumbnails in
the Note Manager view.
Large thumbnail - Displays large thumbnails in the Note
Manager view.
Note mode
Mouse mode – Allows the pen to function as a mouse.
About Note Manager – Displays information regarding this
Note Manager version.
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6.3 Uploading notes onto the computer
1. Start the Note Manager and connect the STAEDTLER digital pen
to the computer.
2. Upon initial start-up of the program, a message appears stating
that the STAEDTLER digital pen is being used in note mode.
Confirm by clicking on OK. This setting can be changed at any
time (see chapter 4.2.1 Functions of the STAEDTLER digital pen
2.0).

Fig. 116 Set Digital Note Mode

Note!
Depending on which setting is selected in chapter 6.1.3 "Mobile" tab,
the notes are automatically transmitted or the process must be
started by the user.
Note!
Selection of the attachment position is not supported here. The
central position at the top is generally pre-set. The Configuration >
Detect hardware menu item remains inactive.
If the STAEDTLER digital pen is not positioned in the top centre or if
an incorrect position is specified here, the notes on your computer will
be skewed!
Mac computer information

This is stored on the Mac computer in TIFF-format when uploading
the handwritten notes onto the Mac computer via the Note Manager
software. Notes in TIFF format, however, cannot be transferred in the
MyScript Studio Notes Edition handwriting recognition software,
whereby conversion of the notes in computer writing is impossible. To
convert the notes in computer writing, uploading must be carried out
via MyScript InkRetriever.
The Note Manager transfers the notes on your receiver automatically
onto the Mac computer and deletes the memory of the receiver. It is
therefore essential that automatic deleting of the receiver memory is
deactivated under Note Taker preferences.

Fig. 117 Deactivating automatic deleting
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3. Select the Upload option in the File menu. All notes on your
receiver are now uploaded onto the computer.
You will be asked upon conclusion of the process whether you would
like to delete all notes on the receiver.
Select Yes to delete all notes on the receiver.
Select No to retain the notes.
Note!
If you select 'No', the notes which are already present on the
computer will not be uploaded again during the next upload.
If the notes are deleted from your computer, however, these notes will
be uploaded again.

6.4 Editing notes
Notes can be edited at any time: regardless of whether they are still
to be drafted or whether the notes are already stored in the Note
Manager.
1. To edit a note, click on the Edit note button
or right-click on
the note and select Edit note in the menu which appears.
The Edit notes window opens with the selected note.

Fig. 118 Edit notes window

2. Edit your note.
Use the Select area
button in the toolbar or the Select option
from the Tools menu to select a specific line or a group of lines.
In the Edit menu, click on Select all to select the entire note.
Note!
It is still possible to continue drawing or writing within the note using
the pen while the note is being edited.
Edit note includes menus and a toolbar to grant you access to a wide
selection of editing functions.
STAEDTLER digital pen 2.0
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The Toolbar is situated on the right-hand pane of the Edit note
window:

Select area – Allows you to select an area by clicking
and dragging with the mouse.
Pen – Allows you to draw freehand using your mouse.
Highlight – Allows you to highlight each area freehand
using your mouse.
Line – Allows you to insert a line of any length.
Circle – Allows you to insert a circle of any size.
Rectangle – Allows you to insert a rectangle of any size.
Text – Allows you to insert typed text.
Change pen / highlighting colour – Allows you to select
or change colour of the pen strokes, the highlighter or
the text.

Line width – Allows you to select or modify width of the
line.

The Manager toolbar is situated below in the Edit notes window.

Erase note completely – Deletes the entire note
represented on the display screen.
Undo – Deletes the previous action.
Repeat – Restores the action previously deleted.
Enlarge – Enlarges view of the note.
Adapt parameter automatically - Returns view of the note
to the original view size.
Reduce – Reduces view of the note.
Rotate to the right – Rotates the entire note image 90° to
the right.
Rotate to the left – Rotates the entire note image 90° to
the left.
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6.5 Printing notes
A note can be printed from any of the 3 note interfaces – the Note
window, the Edit note window or the Note Manager.

6.5.1 Printing a note from a file
1. Click on the note name or on the thumbnail in the Note Manager.
2. Click the Print preview option in the File menu to obtain a preview
of the note prior to printing.
Note!
Several notes can be included in the preview simultaneously. Select
the first note, hold the <Ctrl>-key pressed and then select the other
notes.
3. Select the Print option in the File menu or click on the
button.
4. Select the desired print settings and print properties.
5. Then click on OK.

6.5.2 Printing an opened note
1. Select the Print option in the File menu in the Edit notes window
or click on the

button.

6.6 Storing notes
If the STAEDTLER digital pen is connected to a computer and is in
Note mode, the entry of sketches and notes can be observed
simultaneously on the display screen. As soon as you write or sketch
something with your digital pen, a virtual note sheet appears on your
display screen. These notes can be stored at any time during
creation. They are stored automatically in the standard folder and
named in accordance with date of creation. Once stored, notes can
be renamed at any time.
Click on the Save and close button in the note window toolbar
to store the note in the Miscellaneous standard folder.
Click on the Save in folder
of your choice.

button to store the note in a folder

Note!
It is also possible to set an Auto-save.
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6.7 Renaming notes
When creating and saving a new note, this is automatically named in
accordance with the current date and time. Notes can be renamed at
any time.
1. Right-click on the note which you would like to rename.
2.

Select Rename in the menu which appears. The name is now
highlighted.

3.

Enter a new name for the note.

6.8 Moving notes
It is possible to relocate a note from its current folder to another
folder.
1. Select the name of the note or the thumbnail in the Note
Manager.
2. Click on the Move to option in the File menu.
3. Select the folder into which the note is to be filed.
Note!
The note can also be moved via 'Drag and Drop'.

6.9 Finding notes
It is possible to search for a specific note within your stored notes.
1. Select the Find note option in the Edit menu.
2. Select the folder(s) which you would like to search.
3. To search for descriptions or note names, select By description
and enter the name or the description of the note in the Search for
entry field.
4. To search by creation date parameters, select All notes created
and then enter the time period for which you would like to carry
out the search.
5. Click on Find.
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Fig. 119 Finding a note

6.10 Exporting notes
6.10.1 Exporting as JPEG
Each note can be exported in JPEG file format which can then be
converted to an image file. This proves practical, for example, should
you wish to add notes in documents created in other applications
such as MS Word or PowerPoint.
1. In the Note Manager, select the note which you would like to
export.
2. Right-click on the note name or open the File menu. Select the
Export option. Click on JPEG in the list that appears.
An Export dialogue window appears.

Fig. 120 Exporting note as JPEG file dialogue box

3. Define the desired file name in the File name field.
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4. Define the resolution quality under Resolution.
5. Click on Save.
Note!
It is possible to export several notes simultaneously. Hold the Ctrl-key
pressed on the keyboard and then select the note which you would
like to export in the Note Manager.

6.10.2 Exporting in a file format
It is also possible to export each note in vector format (.pegvf-file) to
allow another digital pen user to import this file into the Note Manager
database.
1. In the Note Manager, select the note which you would like export.
2. Right-click on the note name or open the File menu. Select the
Export option. Click on Export as data file in the list which
appears.
An Export dialogue window appears.

Fig. 121 Exporting note as dialogue box .pegvf file

3. Define the desired file name in the file name field.
4. Click on Save.

6.11 Importing data formats
It is possible to import each file in vector format (.pegvf file) into the
Note Manager database.
1. Select the Import option in the File menu.
The Import dialogue box appears.
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Fig. 122 Importing data dialogue box

2. Select the data which you would like to export.
3. Click on Open.

6.12 Sending / receiving notes
Each note can be sent via e-mail or via the local network. Notes sent
as an e-mail appear to the recipient as a JPEG-attachment. To send
a note in the local network, the receiver must have the Note Manager
software installed, and this software must be active on their computer.

6.12.1 Via e-mail
The Note Manager uses your standard e-mail client to send notes via
e-mail.
Each stored note can be sent as a JPEG or PEGVF file.
1. Click on the note name or the thumbnail in the Note Manager.
2. In the File menu, select the Send to > e-mail option if you would
like to send the note as a JPEG file. Select the Send to > Send
file via e-mail option should you wish to send the note as a
PEGVF file. Alternatively, right-click on the note name or on the
thumbnail and select Send to > e-mail or Send via e-mail as data
file.
A new e-mail form opens with the note as a JPEG or PEGVF
attachment.
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Fig. 123 Note sent via e-mail with JPEG attachment

3. Enter the e-mail address of the desired recipient, the subject and
the e-mail text.
4. Send the e-mail.

6.12.2 Sending via the local network
1. Click on the note name or the thumbnail in the Note Manager.
2. In the File menu, click on the Send to > Network PC option or
right-click on the note name or the thumbnail and select Send to >
Network PC in the menu which appears.
The Send note… dialogue window opens. A list of all network users
installed and initiated by the Note Manager application appears.
3. Select the name or the IP address of the person to which you
would like to send the note. Several recipients can be selected
simultaneously by pressing the <Ctrl> key.
Note!
The note can be sent to all network users in the list by pressing the
Select all button.

4. Click on Send.

6.12.3 Receiving via the local network
It is possible for users of a local network to receive notes via the LAN.
Upon receipt of a note, this appears automatically on your computer
display screen and a signal tone sounds.
Right-click on the received note to obtain the following options:

Fig 124 Options upon receipt via a local network
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Edit & Reply (the user may add text or sketches).
Print note
Save note
Forward note to other network users
Close note
Note!
Notes which have been received via the LAN are stored in the
Received notes folder in the Note Manager.

6.13 Adding notes in other applications
It is possible to add each stored note in another application. In this
case, the note is converted automatically into a JPEG image.
1. Select the note or the thumbnail in the Note Manager.
2. Open the Edit menu or right-click on the note name or the
thumbnail.
3. Select Copy or Cut.
Note!
Cutting the note will delete the note from the current page.
4. Open the application into which you would like to add the note.
5. Select the Add option in the opened application.
Note!
It is also possible to copy the note which you are currently editing. To
do this, click on the

button in the note toolbar.

6.14 Creating sticky notes
Sticky notes can be created in the following manner:
1. Select a note by clicking in the Note Manager.
2. Right-click on the note and select Show as sticky note.
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Fig. 125 Creating a sticky note

Alternatively, click on the Show as sticky note button in the toolbar.

Fig. 126 Show as sticky note button

Note!
The note can also be dragged onto the desktop using the Drag &
Drop feature.
Right-click on the sticky note to obtain further sticky note options.

Fig. 127 Sticky note options
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Convert to text: this option converts handwriting on the sticky note
into text using the MyScript Studio Notes Edition software.
Print: allows printing of the sticky note.
Hide: select Hide to conceal a sticky note in the application icon.
To display a hidden note again, right-click on the application icon
in the taskbar and select My Sticky Notes. Then click on the note
which you would like to restore.

Fig. 128 Restoring hidden notes

Note!
Sticky notes will also be shown again each time the application is
restarted.
Close: closes the sticky note.

6.15 Creating paper holder notes
A paper holder note allows you to view your notes in the foreground
at all times. Furthermore, it is also possible to adjust their
transparency.
1. Select the note which you would like to display in the Note
Manager by clicking on it.
2. Right-click on this note and select Show As Paper Holder.

Fig. 129 Creating a paper holder note
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Alternatively, click on the Show As Paper Holder button in the Note
Manager toolbar.

Fig. 130 Showing as paper holder button

3. Adjust the transparency of your paper holder notes (see chapter
6.1 Defining settings).

6.16 Selecting pen styles
It is possible to modify the colour and width of the on-screen pen
stroke at any time.

1. Open the Configuration menu in the Note Manager. Select the
Pen type option.
2. Click on the arrow on the right-hand side of the current colour to
obtain a list of colours. Select the desired colour.
3. Use the arrows on the right-hand side of the current pen width to
select a pen width between 1 and 10. The desired width may also
be entered directly into the field.
4. Click on OK to confirm selection or click on Cancel to abort
selection.
Note!
Click on the Default button to restore the default settings.

6.17 Managing folders
The Note Manager is installed with predefined folders Miscellaneous,
Deleted Items, Contacts, Follow up, Received Notes and Mobile
Notes.
This folder can be used for storing your notes or, if required, to create
additional user-defined folders.

6.17.1 Creating new folders
A new folder can be created in different ways:
1. Select the folder in which you would like to create a sub-folder by
clicking.
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2. Click in the File menu and select the New Folder option.

Fig. 131 Creating new folders

3. Enter the name of the new folder.

6.17.2 Renaming folders
All folders with the exception of predefined folders Miscellaneous,
Deleted Items, Contacts, Follow up, Received Notes and Mobile
Notes can be renamed.
1. Right-click on the folder which you would like to rename.
2. Click on the Rename option. The file name is now highlighted.
3. Enter a new name for the folder.

6.17.3 Deleting folders
All folders with the exception of predefined folders Miscellaneous,
Deleted Items, Contacts, Follow up, Received Notes and Mobile
Notes can be deleted.
1. Right-click on the folder which you would like to delete.
2. Select the Delete option in the menu which appears.
3. Confirm deleting of the folder with Yes.

6.18 Reminder function
The notes stored on your computer can also be used as reminders.
Define a precise date and a precise time for a selected note so that
this will then appear automatically on your display screen at the
desired time.

6.18.1 Setting a reminder
1. Select a note or the thumbnail in the Note Manager.
2. In the File menu, click on the Set reminder option. Alternatively,
right-click on the note and select Set reminder in the menu which
appears.
3. Tick the Enable Reminder checkbox.
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Fig. 132 Setting a reminder

4. Click on the arrow on the right alongside the Reminder on list and
select the date from the drop-down calendar which appears.
5. Should you wish to determine a specific time for the reminder, use
the arrow alongside the At list or enter the desired time.
Note!
If no specific time is entered, the reminder appears as soon as the
computer is booted on that particular day.
Suppressing the reminder (snooze function)
When a reminder appears, it is possible to suppress this reminder
until it reappears again after 5, 10, 15 or 20 minutes accordingly.
1. Click on Snooze.
2. Select the number of minutes from the drop-down list after which
the suppressed reminder should appear again.

Fig. 133 Setting the snooze function

6.19 Backing up and restoring the note database
It is possible to use the Note Manager as a backup for your entire
database, and to restore this backup as required.
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6.19.1 Backing up the database
1. Select File -->Backup/Restore --> Backup database in the menu.
The following dialogue window appears:

Fig. 134 Selecting a destination path

2. Select the destination path for backup of your database.
3. Click on the Backup button.
4. Once backup has been concluded successfully, the following
message appears:

Fig. 135 Database has been backed up successfully dialogue box

6.19.2 Restoring the database
1. Select File > Backup/Restore > Restore database in the menu.
The following dialogue window appears:

Fig. 136 Selecting a destination path

2. Select the destination path for your database backups.
3. Click on the Restore button.
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4. If successful, your database is restored in a new folder in the Note
Manager.

Fig. 137 Restored database

Note!
This new folder is named "Restored database" and includes the date
on which restore was implemented.
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®

Fig. 138 Editing with BlackBerry smartphone

7.1 System requirements
BlackBerry® OS: 5.0 or higher
Bluetooth®

7.2 Installation of iNote
1. Open BlackBerry App World™ on your BlackBerry®.

Fig. 139 Opening BlackBerry App World

™

2. Enter iNote into the search field and press Enter.

Fig. 140 App World search field

3. Select the free iNote app.
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Fig. 141 Search results

4. Click on Download.

Fig. 142 Search results

You are prompted to enter your BlackBerry® ID. Enter the
corresponding e-mail address and password and click on OK.

®

Fig. 143 BlackBerry ID

5. iNote will now be installed. When the installation is complete, the
following window opens. Confirm the process with OK and click
on Run to start the program.
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Fig. 144 Installation complete

7.3 Working with iNote
7.3.1 Connecting STAEDTLER digital pen 2.0
1. Switch on the digital pen receiver.
2. Activate the Bluetooth® function of the receiver by pressing the
Bluetooth® button.
3. Switch on your BlackBerry® smartphone.
4. Open Options, click on Networks and connections and activate
the Bluetooth® function.

Fig. 145 Networks and connections

5. Select Add new device.

Fig. 146 Adding new device

6. Via Search, display all available devices.
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Fig. 147 Finding devices

7. As soon as the found Mobile Pen is selected, it is automatically
added.

Fig. 148 Found devices

8. When the process has been successfully completed, the receiver
is listed under Paired Devices.

Fig. 149 Paired Devices

9. Now open the iNote application in your BlackBerry® smartphone
and wait until the Bluetooth® symbol turns blue.

®

Fig. 150 Bluetooth connected

Note!
Steps 4 - 8 are only necessary during the first use!
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7.3.2 Creating notes
1. Fasten the receiver to the paper.
2. Begin writing on the paper. A new note window automatically
opens.

Fig. 151 Creating a note

Alternatively, you can open the menu by clicking on the Menu button
. The following window opens:

Fig. 152 Menu

Select the Open new option to create a new note.

7.3.3 Changing note properties
When you create a note, it is possible to change settings such as
background colour, pen colour or pen thickness.
1. Click on the Menu button

.

2. Select the Properties option in the menu.
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Fig. 153 Settings

You can save your settings with the Save button.

7.3.4 Save note
1. Click on the Menu button

.

2. Select the Save option in the menu.

7.3.5 Edit existing notes
1. Select a note by clicking on one in the list.
2. Open the menu by pressing the Menu button

.

3. Click on the Open option.

Fig. 154 Opening a note

7.3.6 Deleting notes
1. To delete a note, select a note by clicking on one in the list.
2. Call up the menu and select Delete.
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Fig. 155 Deleting a note

7.3.7 Sending notes
A note can be sent as an e-mail or an MMS.
1. Open the note you would like to send.
2. Click on the Menu button

and select Send.

3. Depending on whether you would like to send an e-mail or an
MMS, select Send e-mail or Send MMS.
4. Enter the recipient, the subject and text.
5. Click on the Menu button

and select Send.

7.3.8 Downloading the notes from the receiver
1. Open the menu by pressing the Menu button

.

2. Click on the Pen Memory option.
3. Click on Upload to transfer the notes to the BlackBerry®
smartphone.

Fig. 156 Downloading notes from the receiver

7.3.9 Deleting notes from the receiver
1. To delete notes from the receiver, open the menu by clicking on
.
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2. Select the Pen Memory option, then select Erase Memory.
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7.3.10 Photo Sketcher
With Photo Sketcher, you can edit all images in jpeg format.
1. To open Photo Sketcher, click on the Menu button
select Photo Sketcher.

and

2. To edit a picture, click on Open and select an image from the file
list.

Fig. 157 Opening an image

3. You can then edit the picture with the digital pen.
4. To change the pen colour or size, open the menu with the Menu
button

and select the Properties option.

5. When you are done editing, open the menu and select Save to
save the changes. If you don't want to save the changes, select
Discard.
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Fig. 158 Editing with iPhone

Fig. 159 Editing with iPad

8.1 System requirements
8.1.1 System requirements iPhone
iOS 4.0 or higher
iPhone 5, iPhone 4, iPhone 4S

8.1.2 System requirements iPad
iOS 4.1 or higher
iPad, iPad 2, iPad 3, iPad 4 or iPad mini

8.2 Installation
8.2.1 Installation of iPenNote for iPhone
1. Open the Apple App Store on your iPhone.

Fig. 160 Apple App Store

2. Tap on the magnifying glass
STAEDTLER digital pen 2.0

to open the search function.
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3. Enter iPenNote in the search field and start the search by
pressing the Search button.
4. Finally, select iPenNote.

Fig. 161 iPenNote

5. First, tap the Free button. Now install the app by pressing the
Install app button.

Fig. 162 Free button

Fig. 163 Installing app

8.2.2 Installation of iNoteHD for iPad
1. Open the Apple App Store on your iPad.

Fig. 164 Apple App Store

2. Enter iNoteHD in the search field
search by pressing the Search button.

and start the

3. Finally, select iNoteHD.
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Fig. 165 iNoteHD

4. First touch the Free button. Now install the app by pressing the
Install app button.

Fig. 166 Free button

8.3

Fig. 167 Installing app

Connecting STAEDTLER digital pen 2.0

8.3.1 Connecting STAEDTLER digital pen 2.0 with an iPhone
1. Switch the digital pen receiver on by pressing the power button for
approx. three seconds.
2. Activate the Bluetooth® function of the receiver. Hold down the
Bluetooth® button until IRP appears in the display.
3. Switch on your iPhone.
4. Open the preferences and select the General option.

Fig. 168 Settings
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5. Choose the Bluetooth® menu item. If Bluetooth® is not activated,
activate it. The iPhone automatically begins to search for all
available devices and lists them off. The STAEDTLER digital pen
is displayed as Mobile Pen. Tap on the found device to start the
connection process.

Fig. 169 Available devices

Fig. 170 Establishing connection

6. When the process has been successfully completed, the receiver
is displayed as Connected.

Fig. 171 Connected devices

8.3.2 Connecting STAEDTLER digital pen 2.0 with an iPad
1. Switch the digital pen receiver on by pressing the power button for
approx. three seconds.
2. Activate the Bluetooth® function of the receiver. Hold down the
Bluetooth® button until IRP appears in the display.
3. Switch on your iPad.

4. Open the preferences and select the General option.

Fig. 172 Settings

5. Choose the Bluetooth® menu item. If Bluetooth® is not activated,
activate it. The iPad automatically begins to search for all
available devices and lists them off. The STAEDTLER digital pen
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is displayed as Mobile Pen. Tap on the found device to start the
connection process.

Fig. 173 Available devices

6. When the process has been successfully completed, the receiver
is displayed as Connected.

Fig. 174 Connected devices

8.3.3 Starting iPenNote / iNoteHD

As soon as the application is installed, the
/
application
icon appears on the iPhone / iPad. Tap on the icon to start the
program.
After the program has started, the start screen appears.

Fig. 175 iPenNote start screen
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Fig. 176 iNoteHD start screen

Note!
The
display should light up when the receiver has been
successfully connected to the iPhone / iPad. If the display remains
dark, you must repeat the connection process.

8.4 Working with iPenNote / iNoteHD
8.4.1 Downloading and deleting notes from the receiver
1. Start the iPenNote / iNoteHD application.
2. Click on the

icon in the start screen.

3. Select the Upload Pictures option to download the saved notes.
To delete the notes on the receiver, select the Clear my Digital
Pen option.

Fig. 177 Downloading and deleting notes
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8.4.2 Creating notes
1. Start the iPenNote / iNoteHD application.
2. Click on the

icon in the start screen.

3. Select the Create a New Picture option to create a new note.

Fig. 178 Creating a new note

You can now write and draw with the STAEDTLER digital pen on the
note field which appears.
Note!
To ensure correct movement tracking, the paper should be positioned
perpendicularly. The receiver should be located in the top centre of
the paper.

Fig. 179 iPenNote / iNoteHD note field

You can undertake various actions with the function buttons under the
note field.

Fig. 180 Function buttons
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Save and close – click to save or discard the created
note.
Create/open/save picture – click to create a new picture,
open an existing one or save the current one.
Undo – click to undo the last work step.
Forward – click to restore an undone work step.
Empty page – click on the content of the page to delete
it.
Send page – sends the page as a picture of PDF via email.
Rotate page – click to rotate the page 90°, 180° or 270°
to the right.

8.4.3 Save note
Saving and closing
1. Click on the

button.

2. Select the Save picture option in the menu.
3. Confirm the Saved Successfully information with OK and you will
return to the start screen.
Save
1. Click on the

button.

2. Select the Save picture option in the menu.
3. Confirm the Saved Successfully information with OK and you will
return to the drawing.
Note!
The created notes are saved in the photo album of the iPhone / iPad.
Note!
If several drawing levels have been created, each level is saved as a
single picture.

8.4.4 Changing paintbrush properties
1. Click on the paintbrush icon

.

2. A settings window appears in which the paintbrush thickness and
colour can be changed.

121 / 130

STAEDTLER digital pen 2.0

8 Edit notes with your iPhone / iPad
8.4 Working with iPenNote / iNoteHD

Fig. 181 Paintbrush settings

1 The paintbrush thickness is set by moving the slider.
2 Sets the paintbrush colour to white.
3 Sets the paintbrush colour to black.
4 Sets any paintbrush colour.

8.4.5 Rubber
1. Click on the rubber icon

.

2. Define the rubber size with the slider.

Fig. 182 Setting rubber size.

3. Paint over the respective parts of the picture to remove them.

8.4.6 Colour selector
With the colour selector, you can select any colour from a drawing or
picture and use it.
1. Click on the colour selection icon

.

2. To select a colour, tap on any part of the picture.

8.4.7 Changing background image
Different backgrounds can be set for your notes.
1. Click on the clipboard icon

.

2. Flip through the backgrounds with the left/right arrows. Click on
the new background to select it.
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Fig. 183 Changing background image

8.4.8 Hiding tools
1. Click on the icon

to hide the toolbars.

Fig. 184 Hidden toolbars

2. Re-clicking on the toolbar displays it again.

8.4.9 Adding drawing level
Up to 5 drawing labels can be added within one note.
3. Click on the plus symbol

to add a new level.

4. The currently active level is indicated by a white dot.

Fig. 185 Activating drawing level

5. You can switch between the levels by tapping on the respective
level. Inactive levels are indicated by a grey dot.
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6. Click on the minus symbol
level.

to remove the currently active

8.4.10 Opening notes and pictures
1. Click on the

icon in the start screen.

2. Select Open a picture to open an existing note or photo.

Fig. 186 Opening an existing note

3. Then select the Photo Albums option.
4. All saved notes are located in the Camera Roll album.

Fig. 187 Album Camera Roll

5. Tap on the any picture to open it.
Note!
If an already-existing note is opened and edited, a new picture is
created in the photo album of the iPhones / iPads when it is saved.

8.4.11 Taking pictures with the camera
1. Click on the

icon in the start screen.

2. Select the Open a picture option in the menu.
3. Click on Camera to activate the camera.
4. Take a picture.

5. Tap on Use to load the picture into iPenNote / iNoteHD.
6. The recorded picture is loaded as the background image. The
regular symbol options are available.
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Fig.188 Picture with tag
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Photo Sketcher gives you the option of sketching on any JPEG image
file. You can add, save and share comments with others.

9.1.1 Connecting STAEDTLER digital pen 2.0
Connect the STAEDTLER digital pen to your PC with the USB cable
as described in chapter 1.6.7.
Note!
End Note Manager before starting Photo Sketcher.
Note!
The connection via Bluetooth® does not work with Photo Sketcher.

9.1.2 Starting Photo Sketcher
Start Photo Sketcher by clicking on the
desktop.

program icon on your

Note!
You will be requested to end Note Manager if it is still active when the
program starts.
If the receiver is connected to the PC, this is displayed by the
connection indicator. This then illuminates green
. If
there is no connection to the receiver, the icon remains inactive
.

Fig. 189 Photo Sketcher program interface
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Connection indicator – displays whether the receiver is
connected.
Open file – opens a JPEG image on the PC.
Save picture – saves the edited picture on the PC.
Upload picture to Facebook or Flickr.
Send picture – sends the page as a picture via e-mail.
Paintbrush properties – opens settings window to
change the paintbrush thickness and colour.
Rubber – clicking changes to Rubber mode.
Undo – click to undo the last work step.
Forward – click to restore an undone work step.
End program – clicking closes the application.

9.1.3 Opening an image
Directly after the program starts, a dialogue window appears in which
you can open any JPEG file on your PC. This dialogue window can
also be called up via the
program icon. Alternatively, you can
also use the STAG+O keyboard shortcut.
Note!
Photo Sketcher only supports JPG/JPEG picture file types.

9.1.4 Changing paintbrush properties
1. Click on the

button.

2. Select the desired paintbrush thickness and colour in the
Properties window which appears.
3. Confirm your selection with the
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Fig. 190 Paintbrush property settings window

1

Predefined colours

2

Colour matrix for free colour selection

3

Selection of different paintbrush thicknesses

4

Button for confirming settings

5

Display of selected colour

9.1.5 Saving a picture
1. Click on the

button.

2. Select the desired storage location in the dialogue window.
3. Click on Save.

9.1.6 Deleting sketches
1. Click on the rubber

.

2. Move the pen over the areas which you would like to delete.
3. To return to Pen mode, click on the

button.

9.1.7 Sending a picture via e-mail
1. Click on the

button.

2. Your installed e-mail program opens and the picture is attached
as a file.
3. Enter a receiver and click on Send.
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Troubleshooting

10.1 Overview
Problem

Possible cause

Solution

The LCD display is blank
following activation.

The battery of the receiver is too
low.

Connect the receiver to the
computer.

Battery of the pen is too low.

Connect the pen to the
computer.

The refill is not inserted properly.

Insert the refill correctly (see
1.5.3 Inserting / replacing a
refill).

The USB cable is not connected
properly.

Connect the USB cable again.

The USB cable is damaged.

Replace the USB cable with a
new one.

The Note Manager is active.

Start up the Note Manager.

The receiver is not connected
properly to the computer.

Connect the receiver again.

The pen is in mouse mode.

Convert the pen to pen mode
(see 4.2 Online mode).

The pen is out of range of the
receiver.

See 1.6.6 Range of the receiver

The battery of the digital pen is too
low.

Connect the pen to the
computer.

There is an obstacle between pen
and receiver.

Remove the obstacle (see 1.6.5
Attaching the receiver to the
paper).

The pen is being gripped too close
to the pen tip. Transmission from
the pen tip is being blocked by the
fingers.

For correct pen grip, see 1.6.5
Attaching the receiver to the
paper.

The writing underlay is not even
enough or the paper has not been
flattened correctly.

Use a firm and smooth underlay.

The battery of the digital pen is too
low.

Connect the pen to the
computer.

The pen is not in mouse mode.

Convert the pen to mouse mode
(see 4.2 Online mode).

In offline mode, the pen
symbol is not flashing in the
LCD display when writing

The battery symbol is not
flashing during the charging
process.

The pen stroke is not visible
on the display screen in
online mode.

The pen stroke is awry or is
not complete.

The mouse is not
responding.

The pen is out of range of the
receiver.

See 0
Range of the receiver

Text is represented skewed.

Alignment of the receiver is
incorrectly set.

See 4.3 Uploading notes onto
the computer

Two texts have been written
on top of one another

You have forgotten to create a new
page.

Can be rectified in MyScript
Studio Notes Edition, (see 5.5.4
Splitting ink).
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Information regarding disposal
The product, its packaging and the batteries included in delivery have
been manufactured from quality materials which can be reused.
Reusing selected parts or raw materials from used products
contributes substantially to a reduction in waste and to environmental
protection.

11.1 For EC countries
Please dispose of individual components by separating in an
appropriate manner. More detailed information regarding your nearest
recycling collection point can be obtained from your local authorities.

Electronic equipment identified with this symbol may
not be disposed of together with regular domestic
waste!
Every consumer is legally obliged to dispose of electrical waste
separately from domestic waste.
Information regarding recycling collection points which will accept
electrical waste free of charge can be obtained from your local
authorities or city councils.
Do not dispose of batteries together with domestic
waste!
Every consumer is legally obliged to return all empty batteries and
battery packs. Used batteries and battery packs can be surrendered
to public collection points of the local authorities or city councils or to
any shop specialising in the trade of batteries.
Batteries and battery packs containing contaminants are identified
with the following letters:
Pb = Lead, Cd = Cadmium, Hg = Mercury.

11.2 For non-EC countries
Please dispose of individual components in accordance with
directives valid for your respective country.
Apple, the Apple logo, iPhone, iPad, Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.
App Store is a service mark of Apple Inc. "Made for iPhone," and "Made for iPad" mean that an electronic accessory has been designed to
connect specifically to iPhone or iPad, respectively, and has been certified by the developer to meet Apple performance standards. Apple is
not responsible for the operation of this device or its compliance with safety and regulatory standards. Please note that the use of this
accessory with iPhone or iPad may affect wireless performance.
Windows is a registered trademark and property of Microsoft.
BlackBerry® and the BlackBerry® logo are trademarks registered in the U.S. Patent and Trademark Office and can also be applied for and
registered in other countries - these and other trademarks from Research In Motion Limited are being used under license.
The Bluetooth® word mark and the logos are registered trademarks of Bluetooth SIG, Inc. and are being used under license by STAEDTLER
Mars GmbH & Co. KG. Other brands and trademarks are the property of their respective owners. Bluetooth QD ID B016947

STAEDTLER digital pen 2.0

130 / 130

